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Chapter 1.      OVERVIEW OF THE USER MANUAL

This chapter summarizes the layout of this manual and what is covered.

This manual is intended as a reference point for using the VoiceQ ADR and VoiceQ DUB 
applications. For the purposes of this manual both applications are referred to as VoiceQ. 
User training and advice is available as part of your initial  license to use VoiceQ.  Should 
you require additional training at any time please contact KIWA International Ltd (KIWA) or 
its representatives listed in Support.

" Note: While the manual contains an overview of the interaction between VoiceQ 
and the QML language translation service it is not intended to be a user manual 
for that translation service.

Below is a list of symbols used throughout this manual that you should familiarize yourself 
with:

Symbol Meaning
 Action point

 Hint

 Special note

 Use the Command key (Apple)

 Use the Shift key

⌥ Use the Option key 

⌃ Use the Control key

 Warning

Chapter 2.      WHAT’S INCLUDED IN YOUR PACKAGE?
This chapter lets you know what items are included with your purchase of the license to use 
VoiceQ.

With the purchase of your license to use this application, you will receive the following items:

VoiceQ Application and Manual

VoiceQ License

Script Import Manager (SIM) Application and Manual

Each VoiceQ license is a single seat license that enables you to run VoiceQ on an Apple 
Mac computer. KIWA will  also retain a record of your license for support and additional  li-
censes, should you require them. This license will cover you for the current version as pur-
chased, patches and minor version updates will  be made available as part of this license 
fee, however major version updates will be available via license renewal.

Contact information for upgrades and information is listed in Support.

VOICEQ USER MANUAL
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Chapter 3.      REQUIREMENTS

This chapter lists the hardware and software requirements needed to run VoiceQ and in-
structions on how to install your application.

 Note: This program will operate under Apples OSX environment only - 10.4 or 10.5

HARDWARE REQUIREMENTS

Recommended hardware platforms
MacPro Two 2.0 GHz Dual-Core Intel  Xeon 5100 series processors, 1GB of RAM 
or more and OS X version 10.4 or later

Dual 1.8 GHz G5 Power Macintosh, 1GB of RAM or more and OS X version 10.4 
or later

PowerPC G4 Dual Processor 1.25 GHz, 1GB of RAM or more and OS X operat-
ing system version 10.4 or later

iMac PowerPC G5 1.8 GHz, 1GB of RAM or more and running the OS X version 
10.4 or later

iMac 1.83 GHz Intel  Core 2 Duo processor, 1GB of RAM or more and OS X ver-
sion 10.4 or later.

PowerBook G4 1.25 GHz Macintosh, 1GB of RAM or more and OS X version 10.4 
or later

Intel  MacMini  1.66 GHz Intel  Core Duo processor, 1GB of RAM or more and OS X 
version 10.4 or later.

Intel  MacBook 1.83 GHz Intel  Core Duo processor, 1GB of RAM or more and OS 
X version 10.4 or later.

Intel  MacBook Pro 2.0 GHz Intel Core Duo processor, 1GB of RAM or more and 
OS X version 10.4 or later.

Standalone VoiceQ
Standalone mode is defined as VoiceQ being operated on a single Macintosh machine with-
out interaction with ProTools or any other external device or machine. 

Typically, VoiceQ will  be used in standalone mode for the purpose of creating a synchro-
nized VoiceQ Project ready for recording in a studio. VoiceQ requires no additional hard-
ware, which allows all preparation work to be completed outside the Recording Studio if re-
quired. Once the VoiceQ Project has been created, synchronized and checked it can then 
be loaded onto the Studio Machine. 

Single System Configuration
A single system configuration is when VoiceQ is on the same machine as ProTools. This is 
the preferred configuration if the Pro Tools operator will be operating VoiceQ.

Dual System Studio Configuration
A dual  system configuration is when VoiceQ is on a separate machine to that of ProTools. 
The VoiceQ and ProTools machines will  communicate with MTC and MMC via a MIDI inter-
face device. This is the preferred configuration when a separate operator will be using 
VoiceQ. It also reduces system load on the Pro Tools machine.

© 2004-2008 KIWA International Ltd - 8



Video Cards
VoiceQ has been successfully tested on Quartz Extreme and standard video cards delivered 
with Apple machines.

  VoiceQ will not operate on the Rage 128 video card 

Video Grabber/DV Converter Devices
VoiceQ has been successfully tested using live feed with the following Video DV devices 

and ProTools 7.2 and later:

Canopus ADVC55

Canopus ADVC110

DAC-100

DAC-200

 Note: VoiceQ can use these devices to digitize video in real time from any compatible 
source and add the cueing options over that feed. VoiceQ will not output via these 
devices. VoiceQ outputs via the built in DVI port of the Mac video card only. 

MIDI Devices
VoiceQ uses Apples Core MIDI functionality and accordingly is expected to work with most 
MIDI interfaces supported under OS X. VoiceQ has been successfully tested with the follow-
ing MIDI devices:

Mbox Series

002 series

MIDI Sport

Unitor 8

Jog Wheel
The recommended Jog Wheel hardware is the ShuttleXpress and ShuttlePro provided by 
Contour Design Inc  and is available in most countries. Other configurable jog wheel hard-
ware products for Macintosh may also be appropriate.

SOFTWARE REQUIREMENTS

OSX Operating Systems
In conjunction with running VoiceQ on the specific  recommended hardware platforms 
VoiceQ requires Mac OSX. Check our website for the latest OSX compatibility.

OSX 10.5 series release or later (Leopard)

OSX 10.4 series release or later (Tiger)

ProTools Software versions
VoiceQ works with any external Pro Tools system, via a MIDI Interface, irrespective of 
whether it’s on a Windows or MAC based platform.

VOICEQ USER MANUAL
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The minimum recommended ProTools versions when interfaced with VoiceQ on the same 
machine are:

ProTools 6.9 with VoiceQ running on OS X 10.4 series

ProTools 7.1.1 with VoiceQ running on OS X 10.4 series

ProTools 7.2 with VoiceQ running on OS X 10.4 series

ProTools 7.3 with VoiceQ running on OS X 10.4 series

ProTools 7.4 with VoiceQ running on OS X 10.4 or 10.5 series

QuickTime Versions
The minimum recommended QuickTime Player versions are:

QuickTime 7 through 7.5 when running on OS X 10.4.x and 10.5.x

Video Formats
VoiceQ is designed to operate with all  compressed QuickTime movie formats. The recom-
mended codecs are  DV, Motion JPEG and DVC Pro - SD and HD.

As of version 1.8 VoiceQ supports Hi-Def quicktime playback on MacPro and MacBook Pro 
computers. VoiceQ currently supports DVC Pro, Motion JPEG and Photo JPEG Hi-Def co-
decs with true 1920 x 1080 resolution playback.

VOICEQ USER MANUAL
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Chapter 4.      INSTALLATION

Download the latest installer from voiceq.com. Alternatively you may run the install from the 
demo disc provided. 

To authorize VoiceQ you will  need to have an iLok USB smartkey or an Internet connection 
and email facilities. There is an installer package included to install the software.

To install VoiceQ:
1. From DVD: Insert installation disk into DVD drive and copy the VoiceQ Folder to 

your Applications Folder

2. From Website: Unzip the downloaded file and copy the VoiceQ Folder to your Ap-
plications Folder

3. Open the VoiceQ Folder and Launch VoiceQ by double clicking the application

4. You may be prompted to download and install the latest version of  PACE’s inter-
lok extensions which are required for VoiceQ to run. A version of these extensions 
is included in the VoiceQ Folder PACE installer 5.6.2.dmg.

5. Press the ‘Try’ button to use VoiceQ’s 30 day free demo.

6. If you wish to authorize your copy of VoiceQ press the ‘Buy’ button and choose 
from the following authorization methods.

© 2004-2008 KIWA International Ltd - 11
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ILOK USB SMARTKEY

The preferred and best method for authorizing VoiceQ is via an Interlok USB Smartkey. The 
USB Smartkey is widely used to authorize many other products, including Pro Tools. 
Smartkeys are portable and secure allowing users to control  and manage their authoriza-
tions. 

If you already have an iLok USB smartkey and an iLok.com user account please indicate at 
the time of purchase that you want your license authorization credited to your iLok.com ac-
count. When you receive confirmation, simply authorize your USB smartkey using the 
iLok.com interface. Complete instructions can be found on the iLok.com website. If you do 
not already have a USB smartkey, you can purchase from KIWA or directly from the 
iLok.com website.

INTERLOK LICENSE FILE

VoiceQ can be authorized using a license request file that is generated by VoiceQ. This 
authorization will be locked to the machine it was created on. 
To authorize by this method launch VoiceQ on the machine you wish to authorize. Press the 
‘Buy’ button and fill  in the contact information for the license holder. Press the ‘Next’ button. 
Uncheck the ‘Use my iLok Smartkey’ and press the ‘Next’ button. Press the ‘Save license 
request…’ button and save the file to disk. Email  this file to support@voiceq.com. You will 
receive an ‘Interlok License File’ via email. Transfer this to the machine you generated the 
request from. Double click the License file to install the authorization.

CHALLENGE/RESPONSE

A text challenge response authorization method can be used to authorize systems without 
internet/network connectivity. Launch VoiceQ on the machine you wish to authorize. Press 
the ‘Buy’ button and fill  in the contact information for the license holder. Press the ‘Next’ but-
ton. Uncheck the ‘Use my iLok Smartkey’ and press the ‘Next’ button. Press the ‘Next’ but-
ton again to proceed to the Challenge/Response page.

VOICEQ USER MANUAL
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Call VoiceQ Support and indicate you wish to authorize your software using the challenge/
response method. When instructed read the challenge to the KIWA support member. They 
will  then give you the appropriate response, which you should enter into the Response field. 
Press the next button to authorize your software.

" Note: Please check the website for the latest technical and hardware require-
ments.
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Chapter 5.      VOICEQ AND DIGITAL AUDIO WORKSTATIONS 

This chapter describes the configurations and procedures used within VoiceQ and Digital 
Audio Workstations and are intended for use by Audio Engineers to understand the opera-
tion and configuration of both systems.

During the recording process VoiceQ takes over the role of playing back the quicktime 
movie file from Pro Tools. You can leave the quicktime file loaded in your session, but the 
track should be disabled, to avoid competing with the VoiceQ app.

VoiceQ superimposes the scrolling text on the quicktime movie and outputs it via the second 
DVI port of your Macs video card (or the external DVI port on laptops). VoiceQ uses the 
Graphics Processing Unit (GPU) and the Memory on the video card to process the video, 
which reduces the load on the CPU of your computer.

VoiceQ will chase and scrub with Pro Tools while you work in Pro Tools. VoiceQ also has an 
option to cue Pro Tools when you select a line in VoiceQ. This will locate the Pro Tools ses-
sion to the record location for the selected line with an adjustable preroll value. VoiceQ does 
not control Pro Tools in any other way, at this time.

Actual recording of audio and management of playlists still takes place in Pro Tools using 
your normal process.

 Note: In a single system configuration VoiceQ will work with many other recording 
applications including Logic  Pro, Soundtrack and others. Check our website for 
the correct set up instructions and screen shots for these applications. 

 Note: In a dual  system configuration the Digital  Audio Workstation may be any 
device that will output MIDI Time Code (MTC)
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CONFIGURATIONS

STANDALONE CONFIGURATION

Standalone configuration is defined as VoiceQ being operated on a single Macintosh ma-
chine without interaction with Pro Tools or any other external device or machine. VoiceQ is 
typically used in standalone mode for the purpose of preparing a VoiceQ Project ready for 
recording in a studio. Once the VoiceQ Project has been created, synchronized, translated 
and adapted (VoiceQ DUB only) it can then be loaded onto the Studio Machine.

Figure 5.1
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SINGLE SYSTEM CONFIGURATION

VoiceQ may be installed on the same machine as the Digital  Audio Workstation. In this ex-
ample the Digital Audio Workstation is Pro Tools.

Figure 5.2
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Figure 5.3
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DUAL SYSTEM CONFIGURATION

VoiceQ may be installed on a separate machine to your Digital  Audio Workstation (DAW). 
The following diagram describes the procedure to lock VoiceQ to the Digital Audio Worksta-
tion where they are on separate machines. Your DAW will  need to generate the MIDI Time 
Code (MTC) required by VoiceQ.

Figure 5.4
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Figure 5.5

In Figure 5.5 VoiceQ is synchronized to a Digital Audio Workstation via a MIDI Interface. 
VoiceQ will process and output the live video feed to the external display. To do this:

Set MTC Source eg. Pro Tools, to generate MTC in the Session Settings window, 
and send out through the appropriate port.
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VOICEQ WITH PRO TOOLS 7.2

ENABLE THE IAC BUS

To enable Inter Application Communication (IAC) between VoiceQ and Pro Tools:

1. Open the Audio MIDI Setup utility on your Mac HD.

 Macintosh HD > Applications > Utilities > Audio MIDI Setup

2. Double click the red IAC Driver icon
3. Check the Device is Online check box
4. Rename the Bus to VQ & PT
5. Apply the changes
6. Quit Audio MIDI setup
7. Reboot for the changes to take affect

VOICEQ USER MANUAL
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Pro Tools 7.2 settings:
There are five areas within Pro Tools that need to be configured to enable VoiceQ to chase 
correctly.

TIME CODE SETTINGS

In Figure 5.6 below set Timecode Settings from the Session Set Up window to: 

Time Code Settings > Generator: enable MTC To Port
Select: IAC Driver, VQ & PT

Figure 5.6
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MIDI MACHINE CONTROL

In the Pro Tools / Peripherals window (Machine Control tab) set MIDI Machine Control to:

Select Enable
Select: Send To > IAC Driver, VQ & PT
Set the MMC ID to 110

Refer Figure 5.7 below:

Figure 5.7
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MIDI BEAT CLOCK

 In the Pro Tools > MIDI Beat Clock window check: Enable MIDI Beat Clock 
for...

 Enable: IAC Driver, VQ & PT
Refer Figure 5.8 below:

Figure 5.8

VIDEO SCRUBBING

Open the Pro Tools Preferences and select the Synchronization tab.

Check the Machine Chases Memory Location and the Machine Follows Edit Insertion/Scrub 
as in Figure 5.9.
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Figure 5.9 

ENABLING MMC CUEING (MIDI LOCATE) OF PRO TOOLS

To enable MMC cueing of Pro Tools from VoiceQ you will also need to check the Enable 
Control Of Pro Tools Via MMC option in Peripherals >  Synchronization in Pro Tools. 
Change the MMC ID to 120.

Figure 5.10

In VoiceQ check the Output MMC and select Preferences > General > MIDI Locate > Out-
put MMC > VQ to PT to activate the MIDI locate option.

Figure 5.11

VoiceQ will now chase the incoming MIDI timecode from ProTools. VoiceQ will also scrub 
the video and scroll text in response to the MIDI machine control. MIDI Beat clock is used 
for additional synchronization accuracy. The transport controls in VoiceQ can also be used, 
even when VoiceQ is waiting for external MTC. To have VoiceQ chase incoming MTC from 
Pro Tools click on the `Chase External Timecode’ button in the transport section or use the 
Quick Key ⌘J.
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VOICEQ WITH PRO TOOLS 7.3 OR 7.4

ENABLE THE IAC BUS

To enable Inter Application Communication between VoiceQ and Pro Tools:

1. Open the Audio MIDI Setup utility on your Mac HD.

 Macintosh HD > Applications > Utilities > Audio MIDI Setup

2. Double click the red IAC Driver icon
3. Check the Device is Online check box
4. Rename the Bus to VQ & PT
5. Apply the changes
6. Quit Audio MIDI setup
7. Reboot for the changes to take affect
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Pro Tools 7.3 and 7.4 settings:
There are five areas within Pro Tools that need to be configured to have VoiceQ chase cor-
rectly. As of Pro Tools version 7.3 onwards these preferences have moved location.

TIME CODE SETTINGS

In Figure 5.12 below enable Using MTC in the Session setup window.

Timecode Settings > Generator > Using MTC

VOICEQ USER MANUAL
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Figure 5.12
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MIDI MACHINE CONTROL

In the Pro Tools / Peripherals window (Machine Control tab) set MIDI Machine Control to:

Select Enable

Send To: Select IAC Driver, VQ & PT
Set the MMC Master ID to 120

Refer Figure 5.13 below:

Figure 5.13
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MIDI BEAT CLOCK

 In the Pro Tools Setup > MIDI > Midi  Beat Clock window check: Enable MIDI 
Beat Clock for...

 Enable: IAC Driver, VQ & PT
Refer Figure 5.14 below:

Figure 5.14

VIDEO SCRUBBING

Open the Pro Tools Preferences and select the Synchronization tab

Check the Machine Chases Memory Location and the Machine Follows Edit Insertion/
Scrub as in Figure 5.15
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Figure 5.15

ENABLING MMC CUEING (MIDI LOCATE) OF PRO TOOLS

To enable MMC cueing of Pro Tools from VoiceQ you will also need to check the MIDI Ma-
chine Control Remote (Slave) option in Peripherals >  Machine Control in Pro Tools. Set 
the MMC ID to 127.

Figure 5.16

In VoiceQ check the Output MMC and select Preferences > General > MIDI Locate > Out-
put MMC > VQ to PT to activate the MIDI locate option.

Figure 5.17

VoiceQ will now chase the incoming MIDI timecode from ProTools. VoiceQ will also scrub 
the video and scroll text in response to the MIDI machine control. MIDI Beat clock is used 
for additional synchronization accuracy. The transport controls in VoiceQ can also be used, 
even when VoiceQ is waiting for external MTC. To have VoiceQ chase incoming MTC from 
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Pro Tools click on the `Chase External Timecode’ button in the transport section or use the 
Quick Key ⌘J.
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Chapter 6.      OVERVIEW OF APPLICATION

This chapter summarizes the VoiceQ application developed by KIWA International Ltd to 
assist filmmakers and production companies with processing sub titles, audio dialogue re-
placement (ADR) and dubbing of movies for the purpose of broadcasting and theatrical  re-
lease.

VoiceQ provides an automated cueing system for ADR and Dubbing. It scrolls the script 
across the screen (superimposed over the video) and the actor or voice-over artist reads the 
words when they hit the target line. The artist will  be in sync with the lip movements of the 
actor on screen. VoiceQ also provides static  text, audio beeps and visual steamers as cue-
ing methods.

VoiceQ DUB manages scripts in multiple languages, acting as an electronic script with the 
ability to view all line translations by selecting the language version from a menu.

Figure 6.1 - VoiceQ User Interface

VoiceQ provides an abundance of reports including: export script reports, character script 
reports, ADR cue lists and many other useful reports such as character line progress and 
summaries.
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VoiceQ works with the following timecode formats: 23.976, 24, 25, 29.97 drop, 29.97 non-
drop, 30 drop and 30 non-drop frames per second. It also displays time in 35mm film length 
(feet and frames). 

It is possible to alter a number of preferences for the application: the scroll speed of the text, 
the trigger point of the text, display a preview of the line, whether or not the text is displayed 
in the Movie window and whether the output is displayed in a window or on an external dis-
play. These preferences are discussed in Main Menu Items.

An offset can be applied to the session. This is applicable for different specifications held by 
various international film industries. For instance, if the first frame of the quicktime file is 
01:00:00:00 then enter this value in the offset field and also in the scene start time.  These 
parameters may change for each project and VoiceQ allows the values to be set accord-
ingly.  A negative offset can also be applied by entering a negative symbol  preceding the 
offset time code.

 To change the movie offset click in the offset box in the Project Settings drawer 
and change as appropriate.

 Note: any changes in the Script Editor Window are automatically updated in the 
Timeline Editor Window in real time.

A help facility is integrated into the application in the form of this manual as a .pdf file.

 To access the manual  select ‘Help’ from the main menu and select Downloads 
Section on the Support web page.

VOICEQ USER MANUAL
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Chapter 7.      COMMANDS AND TERMINOLOGY 

This chapter describes the commands and terminology used within VoiceQ and is to be 
used as a reference for new users to understand the operation of the application.

PROJECTS

A project has the following parameters:

Each project has a VoiceQ project file (.vqproj) and an associated QuickTime 
movie file.

VoiceQ knows whether or not the file has been edited since it was last saved.

VoiceQ DUB has a primary language and a collection of additional  languages that 
the lines in the project may be translated to. 

Each project has a collection of script characters that are drawn from the script. 
Each character has a name and a color associated directly to that name.

VoiceQ holds a normalized version of the sound wave from the associated QuickTime (if 
there is one) and a modification time for the QuickTime. This normalized version of the 
sound wave is recreated when the QuickTime has its filename specified or if the QuickTime 
changes its modification time (checked on loading). 

SCENES

For the purposes of VoiceQ, a scene shall be a description of the images seen on screen 
between edits.

A scene consists of the following objects/parameters:

A scene name that is unique across the project. 

A relative time from the start of the project (i.e. a movie or reel) which is also the 
relative time from the start of the associated movie file ie. the start time for both 
the first frame in VoiceQ and the first frame in the movie file are relative.

It has a collection of characters associated with that particular scene.

It has a collection of the dialogue lines spoken in the scene.

A scene is viewed on the screen in two places:

On the Script Editor Window with scenes ordered by their relative start times in 
chronological order, as seen in Figure 7.1.
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Figure 7.1

On the Timeline Editor Window as a horizontally scrollable timeline view that also 
displays a waveform of the sound track of the movie file associated with the pro-
ject, as seen in Figure 7.2.

Figure 7.2

From the Script Editor Window we are able to:

ADD A SCENE

Click in the Script Editor Window

Go to ‘Action’ on the main menu

Select ‘Add Scene’ or use Y

DELETE A SCENE

Highlight the scene to be deleted by clicking on that scene

Go to ‘Action’ on the main menu

Select ‘Delete Scene’ or use ⇧Y

EDIT THE SCENE TITLE AND DESCRIPTION

Highlight the scene to be edited by clicking on that scene

Double click on the scene title and description
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Edit the text as desired

You may also add text to the scene description in the `Comments Field’ when the 
scene is highlighted

It is possible to continue and edit the following scene by pressing [return]

To end the editing session, click outside the scene description line

MANUALLY EDIT THE SCENE START TIME

Highlight the start time you wish to change by clicking on that time field

Double click on the start time

Edit the time as desired

  Note: scenes are listed in chronological  order.  If you change the start time of the 
scene so that it comes later than a scene further into the script, then the scene 
you have edited will be moved into a position following the earlier timed scene.

MANUALLY EDIT THE SCENE END TIME

Highlight the start time you wish to change by clicking on that time field

Double click on the end time

Edit the time as desired

LINES

For the purpose of VoiceQ, a line shall be a line of dialogue given to a particular character 
within a scene.

A line of dialogue has the following objects/parameters:

A line number (Num)

A comments field  symbol (Cmts)

A check box  (Done)

Association with a character (Character)

A start time (Start)

An end time (End)

A duration time (Duration)

A word count for that line (Words)

A collection of words spoken in the primary language, and additional  collections 
for each of the translated languages.

Where a line is:

An ordered list of words, each of which has a time where the first word takes 
place expressed as a fraction of the length of an entire line. 

A line of dialogue is viewed on the screen in two places:

On the Script Editor Window by clicking on the symbol beside the scene de-
scription as seen in Figure 7.3. This view shows the words in the line, the line 
number, the comments icon, the `done’ check box, the character, the start time, 
end time and duration of the line; and a count of the words in the line of dialogue.
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Figure 7.3

As an object in the timeline view as seen in Figure 7.4. The line is displayed as a 
single entity, although it is also possible to alter the timings of individual  words as 
described on the following pages.

Figure 7.4

 From the Script Editor Window we are able to:

EXPAND THE VIEW TO INCLUDE CHARACTERS AND LINES

To expand the Scene view, click on the  symbol beside the scene description.

This will  show the characters in the scene together with their lines of dialogue as 
shown in Figure 7.3.

DELETE A LINE

Expand the Scene view to include the characters by clicking on the symbol be-
side the scene description.

Highlight the line to be deleted by clicking on that line.

Select L or

Go to the ‘Action’ item on the main menu

Select ‘delete line’

EDIT THE LINE’S TEXT IN THE CURRENT PRIMARY LANGUAGE

Highlight the line to be edited by clicking on that line. 

Double click the line.

Edit text as desired

 Note: only the primary language lines may be edited, to edit translations select the 
desired language from the language menu.
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CHANGE THE CHARACTER ASSOCIATION FOR THE LINE (OPTION 1) 
All characters are listed in the ‘Character’ column of the Script Editor Window. 

Expand the Scene view to display the characters by clicking the  symbol beside 
the scene description.

You will see a default character in a color-coded box.  Click on the character 
name.  This will  show you a list of the possible characters in this scene that may 
be saying the line.

Select a character by clicking on the character name. 

Release the mouse button when you have a tick beside the character you wish to 
use, and you will return to the expanded Script Editor Window.

  Make sure you really want to change the character name before proceeding with 
this action. You can undo it using Undo (⌘Z).

MANUALLY EDIT THE LINE START TIME

Expand the Script Editor Window to include characters and lines.

Double click on the Start Time box.

Edit the Start Time as required.

MANUALLY EDIT THE LINE END TIME

Expand the Script Editor Window to include characters and lines.

Double click on the End Time box.

Edit the End Time as required.

MANUALLY EDIT THE DURATION

Expand the Script Editor Window to include characters and lines.

Double click on the Duration box.

Edit the Duration Time as required.

 Note: Changing the duration will change the End Time of the line.

DRAG A HANDLE AT THE START OF THE LINE TO CHANGE THE START TIME

Figure 7.5
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In order to drag the entire line to change the start and end times but keep the du-
ration the same, click on the rounded left hand side (handle) of the line as in Fig-
ure 7.5.

Holding your mouse button down, slide the line to the left to make it start earlier, 
or to the right to make it start later.

Release the mouse button when you are happy with the changes.

 Note: The time code (in blue font) is automatically displayed to assist in this opera-
tion.

 Hint: Use the ‘audio waveform’ to help determine the start of the line. You can also 
use the left and right arrow keys to nudge words left or right for fine tuning.

DRAG A HANDLE AT THE END OF THE LINE TO CHANGE THE END TIME

Figure 7.6

In order to change the end time of the line, drag click on the pointed area on the 
right hand side (handle) of the line as in Figure 7.6. A blue guide line will  appear, 
this displays the sync point for that word.

Holding your mouse button down, slide the line to the left to make it end earlier, or 
to the right to make it end later.

Release the mouse button when you are happy with your changes.

 Note: When doing this, words may be hidden in the dialogue box.  Optimum han-
dle positioning will minimize this.

 Hint: Expand the timeline view to view all words in the line
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DRAG A WORD TO CHANGE THE INDIVIDUAL WORD TIMINGS

Figure 7.7

In order to change the position of the individual words in the line, click on the be-
ginning of the word (handle) as shown in Figure 7.7.

Holding your mouse button down, slide the line to the left or right to change the 
start of the word.  

Release the mouse button when you are happy with your changes.

Hold the control key while dragging to affect all words before the one selected.

Hold the option key while dragging to affect all words in the line

Hold the command key while dragging to affect all words after the one selected.

 Note: You will not be able to change the order of the words.

 Hint: Align the blue guide line to the correct place on the audio waveform for quick 
syncing.

UNDO AND REDO

VoiceQ features multiple levels of undo and redo which allows you to ‘Undo’ the previous 
action. VoiceQ stores 64 levels of Undo. If you make a mistake at any time for example de-
leting the wrong line, then use the undo command.

Select Undo (⌘Z)from the edit menu Edit > Undo to undo the previous action.

Select Redo (⌘Z) from the edit menu Edit > Redo to redo the previous action.

NUMBERING

A unique number is automatically assigned to a line of dialogue.

The VoiceQ application will  automatically assign a number (in numerical order) in the Script 
Editor Window number column. It will automatically update the number column when you 
add or delete lines.
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 Note: You are able to preserve the numbering by selecting ̀ Locked Line Numbers’ 
from the Edit Menu. The number associated with each line will  now be perma-
nently associated with that line.

 Note: To enable VoiceQ to automatically renumber the lines select `Locked Line 
Numbers’ again from the Edit Menu. A dialogue box will appear asking you to con-
firm whether you wish to proceed with unlocking the numbering. Select `Unlock’ or 
`Cancel’ as appropriate. VoiceQ will now continue to automatically renumber lines.

 Hint: Use the `Locked Line Number’ mechanism for ADR sessions where you want 
each line number to be retained.

COMMENTS

You are able to assign comments to each scene and line of dialogue.

The VoiceQ application will  automatically place a ̀ Comment Bubble Icon’ in the Script Editor 
Window comment column. It will  automatically update the comment column when you add 
or delete comments. 

In order to add, edit or delete comments for a scene or line, click on the line in the 
Script Editor Window. 

In the comments field window, located between the Script Editor and Timeline Edi-
tor Windows enter your comments.  

Press enter or click away from the comments field to save your comments or 
changes.

 Note: When you delete a comment the `Comment Bubble Icon’ will automatically 
disappear.

 Hint: Use the `Comments’ field in all phases of production. eg. description of a 
scene, delivery of a line, adding Director, Engineer or Actor notes etc.

DONE

You are able to measure and monitor progress of a production at any time by utilizing the 
`Done’ check box. It can be toggled on or off as desired.

When selected, the VoiceQ application will automatically place a `Tick’ in the Script Editor 
Window `Done’ column next to the corresponding line. To delete the tick merely click the 
check box. 

 Note: When all  lines in a scene are ticked the scene check box will automatically 
update as being done.

 Hint: Use the `Done’ check box in any and all  phases of production as appropriate. 
Eg. progress status of; translation/adaptation, synching, detection, recording, edit-
ing, mixing, foley etc

START TIME CODE

The start time code is the time code point at which a scene or line begins as shown in the 
sixth column in Figure 7.8.

The start time shown beside the scene description (top line) is the start time of the scene.

The start time shown beside the line of dialogue is the start time of that line to be spoken.
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Figure 7.8

END TIME CODE

The end time code is the time code point at which a scene or line ends as shown in the sev-
enth column on Figure 7.9.

The end time shown beside the scene description (top line) is the end time of the scene.

The end time shown beside the line of dialogue is the end time of that line to be spoken.

Figure 7.9

DURATION

The total duration of the scene or line is shown in Figure 5.10 in the eighth column.

The duration shown on the scene description line (top line) is the duration of the entire 
scene.

The duration shown beside the line of dialogue is the duration of the line to be spoken.

Figure 7.10

WORD COUNT

The word count represents the number of words spoken in a complete scene or line as 
shown in Figure 7.11 in the far right hand column.

The number beside the scene description (top line) is the total  number of words in that 
scene.  

The number beside the line of dialogue is the number of words in that line to be spoken.

Figure 7.11
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CHARACTER

Character refers to the screen name of the artiste speaking the lines.  In the Figure 7.12, we 
have the characters Narrator, Pauper and Servant.

It is possible to change the character association with a line.

Figure 7.12

CHANGE THE CHARACTER ASSOCIATION FOR THE LINE (OPTION 1) 
The character association is listed in the ‘Character’ column of the Script Editor 
Window. 

Expand the Scene view to include the characters by clicking the symbol  beside 
the scene description.

You will  see a character in a color-coded box.  Click on the character name.  This 
will  show you a list of the possible characters in this scene that may be saying the 
line.

Select a character by clicking on the character name. 

Release the mouse button when you have a tick beside the character you wish to 
use, and you will return to the expanded Script Editor Window.

  Make sure you really want to change the character name before proceeding with 
this action.

CHANGE THE CHARACTER ASSOCIATION FOR THE LINE (OPTION 2) 
Ensure the Character screen is showing by typing 8 or clicking on ‘Window’ 
from the main menu and selecting Characters…

You will  see a list of characters in the lower half of the window that are associated 
with the current scene.  Click on the character you want to change the line asso-
ciation to.

Holding your mouse button down, drag the character name onto the line of dia-
logue in the Script Editor Window that you wish that character to be associated 
with.

Release your mouse button.

CHARACTER WINDOW

This window shows the characters listed on the imported script, their default color-coding 
and where their lines will show on the movie screen.
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Figure 7.13

 From the Character screen we are able to:

ADD CHARACTERS 

Ensure the Character screen is showing by typing 8 or clicking on ‘Window’ 
from the main menu and selecting Characters…

To add a Character Click on add character button  at the centre of the Charac-
ter screen as shown in Figure 7.13.

This will create a new character in the upper half of the screen.  Enter your new 
character name here.

When you have completed adding your character, click outside the box.

 Note: If you press [return] when you have completed adding or editing the charac-
ter name, the cursor will  move to the next character in the list or where there isn’t 
one, will insert a new one.

CHANGE THE NAMES OF CHARACTERS

Ensure the Character screen is showing by typing 8 or clicking on ‘Window’ 
from the main menu and selecting Characters…

Double click on the Character you wish to change.

Edit the highlighted name and click outside the window.

 Note: if you press [return] when you have completed editing the character name, 
the cursor will move to the next character in the list or insert a new one.

CHANGE THE COLOR ASSOCIATION OF A CHARACTER

Ensure the Character screen is showing by typing 8 or clicking on ‘Window’ 
from the main menu and selecting Characters…

Click on the Character you wish to change.

Click on the colored square to the right in the centre of the window as seen in Fig-
ure 7.14.
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Figure 7.14

A color palette will show on the screen. Move the cursor around the palette until 
you’ve selected the color you like. 

When you have made your color selection click on the red circle at the top left 
hand side of the color palette to save the color  selected and close the palette.

 Note: While it is possible to have two or more characters with the same color 
code, this is not advisable.  As a rule all  characters should have different colors to 
differentiate between characters and enhance the recording session process.

REMOVE A CHARACTER

Ensure the Character screen is showing by typing 8 or clicking on ‘Window’ 
from the main menu and selecting Characters…

Click on the Character you wish to remove.

Click on the remove button  in the middle of the screen as seen in Figure 7.15.

Figure 7.15

A warning message will  show on screen asking if you are sure you want to delete 
this character.

  Removing a character will delete all dialogue lines associated with that character

TURN ON/OFF THE DIALOGUE DISPLAY ASSOCIATED WITH A CHARACTER

Ensure the Character screen is showing by typing 8 or clicking on ‘Window’ 
from the main menu and selecting Characters…

Click in the `check box’ next to the Character(s) who’s dialogue you wish to have 
displayed on screen. This is confirmed by way of a `’ in the check box as seen 
in Figure 7.15.

CHANGE THE POSITION OF THE CHARACTER LINES ON THE SCREEN

In the lower half of the Character screen as shown in Figure 7.16, you will  see a list of the 
characters in the current scene.  In the second column is a heading ‘Alt.’.  Alt. stands for Alti-
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tude and allows you to determine where each character’s line is to be horizontally displayed 
`on screen’.  In this column you will  see a percentage number.  This percentage number in-
dicates the altitude level of that characters dialogue on the Movie screen.  In Figure 516, for 
instance, the character Prince would be 5% from the bottom of the screen, Servant at 20%, 
Narrator at 10% and Pauper at 0%.  Maximum altitude is 100% and it works in increments of 
5% blocks. It is possible to select increments of less than 5% by entering the percentage 
directly in the Altitude field.

Figure 7.16

Ensure the Character screen is showing by typing 8 or clicking on ‘Window’ 
from the main menu and selecting Characters…

Click on the up or down arrows or double click the percentage field to change the 
vertical altitude percentage for the relevant character(s).

  Note: This altitude measurement will  affect all  lines for that character in the project 
and not just the current scene.  It is important therefore to check that characters, 
whose lines in the same scene are interactive, don’t have the same altitude per-
centage or their lines may overlap.

  Note: While it is possible to position the lines of two or more characters at the 
same altitude, in the same scene this is not advisable.  As a rule all characters 
should have different altitudes to differentiate between characters and enhance 
the recording session process.

CHANGE THE CHARACTER ASSOCIATION FOR THE LINE 

Ensure the Character screen is showing by typing 8 or clicking on ‘Window’ 
from the main menu and selecting Characters…

You will  see a list of characters in the lower half of the window that are associated 
with the current scene.  Click on the character you want to change the line asso-
ciation to.

Holding your mouse button down, drag the character name onto the line of dia-
logue in the Script Editor Window that you wish that character to be associated 
with.

Release your mouse button.

FILTER BY CHARACTER

You are able to filter all lines associated with a single character and have them displayed in 
the Script Editor View and screen display. When a character is selected from the drop down 
list of available characters, the VoiceQ application will  automatically place a ̀ Tick’ next to the 
selected character’s name in the Filter Window. To disable the filter select `No Filter’ from 
the drop down list, as shown in Figure 7.17.
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Figure 7.17

 Note: All lines associated with the selected character will  appear in the Script Edi-
tor Window. When in a `character filtered state’ you are not able to change the 
character association of a line, hence the character drop down list will not be visi-
ble.

 Hint: To increase the speed when recording one character at a time, use the 
`Character Filter’. 

 Hint: Try creating a character specifically for audio mixing, foley and/or other spe-
cial effects and use the filter to cue accordingly.

CONTROLLING VOICEQ
When in standalone mode VoiceQ will  function like a VTR (Video Tape Recorder) or DAW 
(Digital Audio Workstation). Simply click in the timeline where you wish to play and press the 
space bar, VoiceQ will  begin playing from the selected point. You may also type timecode 
values directly into the timecode counter display and press return, VoiceQ will locate to the 
entered timecode. Tolcate to a line select the line in the script view. You can play the se-
lected line by clicking in the timeline view and pressing space or use the play with pre-roll 
function control spacebar.

Select the chase button to have VoiceQ chase incoming MIDI timecode. The button will glow 

orange  when chase mode is on and is waiting for incoming code. It will glow green  
when it is receiving MIDI timecode and chasing. The other transport controls will grey out 
while VoiceQ is chasing the incoming code.

TRANSPORT CONTROLS

Item Description
Chase incoming MIDI timecode
Return to start of project

Rewind frame by frame 

Play and stop

Forward frame by frame

Go to end

Table 7.1
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Using the transport controls we are able to:

START AND STOP THE QUICKTIME MOVIE

To start or stop the QuickTime movie click on the play button as shown in 

Figure 7.20. When playing, the button will glow green  indicating that VoiceQ 
is playing. Clicking on this button will stop the QuickTime movie from playing.

Quick Key: space bar key

REWIND THE QUICKTIME MOVIE

To rewind the QuickTime movie frame by frame, click on the rewind one frame 

button  as shown on the left hand side in Figure 7.20.

Quick Key: command minus (⌘-) key

Use option and command plus (⌥⌘-) to rewind by a second

Use control, option and command plus (⌃⌥⌘-) to rewind by 10 seconds

ADVANCE THE QUICKTIME MOVIE

To advance the QuickTime movie frame by frame click on the frame advance but-

ton  shown on the right hand side in Figure 7.20.

Quick Key: command plus (⌘+) key

Use option and command plus (⌥⌘+) to advance by a second

Use control, option and command plus (⌃⌥⌘+) to advance by 10 seconds

RETURN TO THE START OF THE QUICKTIME FILE

To return to the start of the QuickTime movie, click on the return to start button 

 as shown in Figure 7.20.

To go to the end of the QuickTime movie, click on the go to end button  as 
shown in Figure 7.20.

Quick Key: Beginning of movie: return key

 Note: To go to any parts of the movie enter the appropriate timecode in the time-
code field and press enter or click on the appropriate scene or line. Or simply click 
on the desired location in the timeline window.

 Note: VoiceQ also supports the ShuttleXpress and Shuttle Pro Jog Wheel that can 
be configured to perform the above functions.

SET THE DESTINATION FOR THE OUTPUT WINDOW

To instruct VoiceQ where to display the output window (with the quicktime movie 
and scrolling text), select ‘VoiceQ Preferences’ from the main menu.  There are 
two destinations available:

1. Preview window on main screen

2. Preview window on secondary screen
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You can also switch between output modes using the External Monitor button  
or the quick key F8.

 Note: You must have a secondary screen connected to your machines DVI port 
before this option is available. VoiceQ will output the QuickTime movie to your 
main screen by default.

SET THE FRAME RATE OF THE VOICEQ PROJECT

To set the frame rate of the VoiceQ project, ensure the Project Settings drawer is 
open by typing command 9 (⌘9). 

Figure 7.18
Select your desired frame rate by highlighting the menu with your cursor and releasing the 
mouse button. 

Figure 7.19

UPLOADING / DOWNLOADING WITH QML
Uploading (sending) or Downloading (receiving) is the action of sending or receiving VoiceQ 
DUB files to and from QML.

The upload/download commands are found in the file menu.

 Note: This facility is only available to users subscribed to QML and using VoiceQ 
DUB.

TO UPLOAD A PROJECT FROM VOICEQ DUB TO QML
1. Select ‘File’ from the main menu

2. Drag your cursor down to ‘Upload to QML’

3. Select ‘project’ or ‘scene’

4. Release mouse button.

5. This will  automatically open an internet connection to QML and upload the project 
or scene from VoiceQ DUB into QML
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 Note: All language-translated scripts will be exported along with the primary lan-
guage

TO DOWNLOAD A PROJECT INTO VOICEQ DUB FROM QML
1. Open a new VoiceQ project

2. Create the required languages 

3. Select ‘File’ from the main menu

4. Drag your cursor down to ‘Download from QML’

5. Select ‘project’ or ‘scene’

6. Release mouse button.

7. This will  automatically open an internet connection to QML and download the pro-
ject or scene into VoiceQ DUB

 Note: all language-translated scripts will  be imported into VoiceQ DUB along with 
the primary language

 Note: In order to download a QML project you must first have uploaded it to QML.

It is possible to download a full script from the QML system once you have registered there 
as a QML user. This interface will  automatically format the export script in order for it to be 
received by the VoiceQ DUB application. 

More information on the QML product and interface can be obtained from:

KIWA International Ltd

Email: info@voiceq.com 
Website:  www.voiceq.com

IMPORTING SCRIPTS

KIWA has now developed the Script Import Manager (SIM) to handle preprocessing of 
scripts, correcting timecode and formatting. This will ensure easy importing of scripts into 
VoiceQ.

Please see the Script Import Manager manual for instructions on creating a file ready for 
importing to VoiceQ.

There is a strict structure in which a script must be imported or input into VoiceQ in order for 
the application to read the file. SIM will create this file from any text, word or excel file.

INPUT DIRECTLY INTO VOICEQ
It is possible to input data directly into the VoiceQ application if you only have a printed copy 
of your export script, or if you prefer to enter it directly into VoiceQ. This process will be cov-
ered under Creating a Project.

IMPORT TEXT FILE INTO VOICEQ
It is possible to import a text file of the script directly into the VoiceQ application. The file be-
ing imported must be in a tab delimited plain text file using UTF8 text encoding.

1. Select ‘File’ from the main menu
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2. Select `Open’ and navigate to the desired text file

3. Choose `Open’ to select the file

 Note: VoiceQ requires that the text file is formatted in a specific way to ensure the 
correct values are imported to the correct fields.  For instance we want the Char-
acter name to be in the Character column and not, for example, in the time code 
column. Therefore VoiceQ will  ignore lines that do not comply with the formatting 
standards. VoiceQ will alert you to lines that were ignored during the import proc-
ess.

 Note: The two formats for importing data are: 1. where there is no time code, and 
2. where the time code is included in the script.  Where a time code is not part of 
the imported data, VoiceQ will insert time codes based on pre-programmed esti-
mates. It is possible to combine the two format options when occasional  time code 
information is available or just start timecode values.

You can format text files for VoiceQ in Apple’s Text edit, Microsoft Word or a similar text edit-
ing program. Please ensure the file is simple text (not rich text or any other proprietary for-
mat) and encoded using Unicode UTF-8. If your text editing application has an option to 
view invisible characters (tabs and carriage returns) turn it on to help in the formatting proc-
ess. 

Note: [tab] denotes a tab and should not be typed, [return] and [cr] denote a carriage return 
(also called return, new line and line feed).

FORMAT WHERE TIME CODE IS INCLUDED

A code is required at the head of the text file to indicate that it has been formatted for 
VoiceQ (%!VoiceQ/). This may optionally include the timecode format of the script (in this 
example 29.97) which may be any of the following frame rates: 23.976, 24, 25, 29.97, 
29.97d, 30, 30d.

The first line of the file should read:

%!VoiceQ/29.97 [return]

***Scene description [tab] Start time code [return]

# insert scene comments here [return]

Character [tab] Start time [tab] End time [tab] spoken line in primary 
language [return]

# insert line comments here [return]

Character [tab] Start time [tab] End time [tab] spoken line in primary 
language [return]

# insert line comments here [return]

***Scene description [tab] Start time code[tab] End time code [return]

# insert scene comments here [return]

Character [tab] Start time [tab] End time [tab] spoken line in primary 
language [return]

# insert line comments here [return]
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etc etc etc

Example
%!VoiceQ/25
***Page telling bad jokes
 00:00:01:00
 00:00:56:02
# scene comments
Page
 00:00:21:15
 00:00:24:10
 Hey Jack I'm, I'm really sorry 
about Vince
# line comment
Jack
 00:00:26:00
 00:00:26:08
 Ta
# more line comments
Page
 00:00:32:11
 00:00:33:04 
 (SFX lip smack)
# line comment for Sound mixer
Page
 00:00:33:19
 00:00:36:10
 What’s long, brown and sticky?
Jack
 00:00:36:16
 00:00:37:00
 A stick
Page
 00:00:40:10
 00:00:42:21
 This horse walks into a bar and the 
barman says
Jack
 00:00:43:10
 00:00:44:19
 Why the long face
Page
 00:00:46:23
 00:00:48:11
 This guy walks into the bar and
Jack
 00:00:48:15
 00:00:50:00
 And then he dies
Page
 00:00:54:06
 00:00:56:02
 Don't think I've heard that one

FORMAT WHERE TIME CODE IS NOT INCLUDED

A code is required at the head of the text file to indicate that it has been formatted for 
VoiceQ. The first line of the file should read:

%!VoiceQ/[return]

Then a Scene heading and scene start timecode

***Scene description [tab] Start time code [return]

Then a Character name and line

Character [tab] [tab] Line [return] #Comment [return]

The following file format must be adhered to in all cases:

Format
%!VoiceQ/ [return]
***Scene description [tab] Start time code [return]

# insert scene comments here [return]

Character [tab] [tab] spoken line in primary language [return]

# insert line comments here [return]

Character [tab] [tab] spoken line in primary language [return]

# insert line comments here [return]
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***Scene description [tab] Start time code [return]

# insert scene comments here [return]

Character [tab] [tab] spoken line in primary language [return]

# insert line comments here [return]

etc etc etc

Example
%!VoiceQ/ [return]
***Page telling bad jokes
 00:00:01:00
Page
 
 Hey Jack I'm, I'm really sorry about Vince
Jack
 
 Ta
Page
 
 (SFX lip smack)
Page
 
 What’s long, brown and sticky?
Jack
 
 A stick
Page
 
 This horse walks into a bar and the barman says
Jack
 
 Why the long face
Page
 
 This guy walks into a bar and
Jack
 
 And then he dies
Page
 
 Don't think I've heard that one!

EXPORT SCRIPT FORMAT COMMAND DETAILS

Detail Action
%!VoiceQ/ Creates a project in VoiceQ

*** [scene description] Creates a scene in VoiceQ under the new project.  
Character [tab] Will insert the character’s name in the character field.
[tab][tab] Will  instruct VoiceQ there is no time code available 

for that line of dialogue

spoken line in primary 
language

Will insert the spoken line of dialogue

[tab]time[tab]time Will  insert the start and end time code into the time 
code fields

# Will  insert a comment or note associated to that line 
or scene

[return] Will instruct VoiceQ it is the end of the spoken line
Table 7.2

Lines without a time code will  have their times estimated based on a set of algo-
rithms in the VoiceQ application.  It is possible to change the time codes later.

Scenes without time codes are assumed to start at the end of the previous scene.  
Again, timings will be estimated based on a set of algorithms in the VoiceQ appli-
cation.

Times are assumed to be chronological and where a time is listed out of sequen-
tial order it is regarded as a non-compliant line and will be flagged as an error.
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VoiceQ will produce a visible post import report on any lines that were missed 
during the process and display them for appropriate action.

 Hint: Make sure VoiceQ FPS is set correctly before importing the text file if the 
frame rate is not specified in the text file.

 Hint: Many database style software applications, eg.

Filemaker Pro, can output the required tab delimited .txt files to aid in this process. 
In Filemaker Pro select the records you wish to output. Select File > Export Re-
cords… and save the file as a tab delimited text file.

 Hint: A spreadsheet application, eg. Excel will  also export as a tab delimited .txt 
file. Just move the columns so they are in the correct order. Name, timecode start. 
timecode stop, dialogue line.

 Note: Microsoft Word is not recommended for the creation of import .txt files. It is 
known to add many hidden styles and formatting that impedes the data conver-
sion process. We recommend Apple’s ‘Text Edit’ or BBedits ‘Text Wrangler’ which 
are available free although any other ‘simple text’ editor maybe appropriate.

LINK TO MOVIE FILES

VoiceQ must have a script and an associated Movie in order to process the pertinent infor-
mation; therefore all VoiceQ projects must be associated with a QuickTime Movie file (un-
less using live feed mode).

TO LINK VOICEQ TO A QUICKTIME MOVIE FILE

From the main menu select the ‘File’ option.

Select ‘Associate QuickTime’

This will  open up your explorer window.  Navigate to the QuickTime movie file you 
wish to associate with the VoiceQ project.

Click on the file name.

Select ‘Open’ or double click on the file

Your QuickTime Movie file will be opened

TO USE VOICEQ WITH A LIVE VIDEO FEED

Ensure your DV converter is attached via Firewire

Play your external video source

From the main menu select the ‘File’ option.

Select ‘Use Live Feed’

This will display the live feed from the DV Converter
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SCRIPT EDITOR WINDOW

Figure 7.20

The screen in Figure 7.20 shows a list of the scenes in the project together with the Com-
ments, Done check box, Start and End Time codes, the Duration of the scene and the num-
ber of Words spoken during that scene.

Figure 7.21

The screen in Figure 7.21 is an expanded view of the Script Editor Window. To expand to 
this view click on the  symbol beside the scene description.  It shows the scene descrip-
tion, line numbers, comments bubble, done checkbox, start and end time codes, word count 
of the scene and lines, together with the color coded characters and their lines for that 
scene. The window immediately below this screen is the `Comments Field’ where comments 
can be added and associated with each scene and line.

 From the Script Editor Window we are able to:

SAVE AN EXISTING PROJECT

Click on ‘File’ in the main menu

Select ‘Save’ or use S

 Note: if you choose to save your project you will  not be able to revert back to a 
prior version.

 Hint: Use `Save As’ to save iterations of your project should you wish to revert 
back to any project versions

SAVE AN EXISTING PROJECT WITH A DIFFERENT NAME

Click on ‘File’ in the main menu
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Select ‘Save As’ or use S

 Note: This is useful if you want to retain each iteration of your project as you are 
editing.

OPEN AN EXISTING PROJECT

Save the current VoiceQ project.

Click on ‘File’ in the main menu

Select ‘Open’ (O) to select a file previously saved

Or select ‘New’ (N) to create a new file

 Note: If you already have a project open and ask VoiceQ to load a new project or 
open an existing project, VoiceQ will close the current project after asking you if 
you want to save it – ensure you save your current open project before opening a 
new one.

REVERT THE PROJECT TO THE PRE-EDITED STATE

Click on ‘File’ in the main menu

Select ‘Revert’

 Note: You cannot revert back to a pre-edited project if that project has been 
saved. Revert will only take you back to the last save action. 

EXPAND VIEW TO SHOW PRIMARY AND OTHER LANGUAGES

To expand the Scene view, click on the  symbol beside the scene description.

This will  show the characters in the scene together with their lines of dialogue (as 
shown in Figure 7.21)

To expand the view further click on the  symbol beside the primary language 
line.

This will show both the primary and secondary languages as shown in Figure 
7.21)

 Note: Use the option/mouse click method to open all dialogue and languages. 

ADD A NEW (BLANK) SCENE TO THE PROJECT 

Expand the Scene view to include the characters by clicking on the  symbol 
beside the scene description.

Click in the white area on the screen.

Go to the ‘Action’ item on the main menu

Select ‘Add Scene or use Y

ADD/INSERT A NEW LINE INTO THE SCENE 

Expand the Scene view to include the characters by clicking on the  symbol 
beside the scene description.

Click on a scene description where you want the line inserted.

Go to the ‘Action’ item on the main menu

Select ‘Add Line’ or use L
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CHANGE THE WIDTH OF THE COLUMNS

Figure 7.22

Click in the column headings row on the line between the columns.

Drag the line to the left or right by holding down your mouse button.

Release your mouse button.

 Note: It is not possible to sort the data in the columns as VoiceQ automatically 
sorts the columns chronologically

EDIT THE LINE’S TEXT IN THE CURRENT PRIMARY LANGUAGE 

Highlight the line to be edited by clicking on that line. 

Double click the line.

Edit text as desired

 Note: Only the primary language lines may be edited. To edit other languages you 
must switch to that language using the language menu.

DELETE A LINE

Expand the Scene view to include the characters by clicking on the  symbol 
beside the scene description.

Highlight the line to be deleted by clicking on that line.

Go to the ‘Action’ item on the main menu

Select ‘delete line’ or use L

CHANGE THE CHARACTER ASSOCIATION FOR THE LINE (OPTION 1) 
The character association is listed in the ‘Character’ column of the Script Editor 
Window.

Expand the Scene view to include the characters by clicking the  symbol beside 
the scene description.

You will  see a character in a color-coded box. Click on the character name.  This 
will  show you a list of the possible characters in this scene that may be saying the 
line.

Select a character by clicking on the character name. 
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Release the mouse button when you have a tick beside the character you wish to 
use, and you will return to the expanded Script Editor Window.

 Note: You can set the character associated with a line by dragging the characters 
name from the list on the left and dropping it on the line.

  Make sure you really want to change the character name before proceeding with 
this action. Note:  You can undo this by typing command Z (Undo).

MANUALLY EDIT THE START TIMECODE

Expand the Script Editor Window to include characters and lines.

Click on the Start Time box.

Edit the Start Time as required.

MANUALLY EDIT THE END TIMECODE

Expand the Script Editor Window to include characters and lines.

Click on the End Time box.

Edit the End Time as required.

MANUALLY EDIT THE DURATION

Expand the Script Editor Window to include characters and lines.

Click on the Duration box.

Edit the Duration Time as required.

 Note: Changing the duration will change the End Time of the line.

FORCE A RESCAN OF THE WAVEFORM FROM THE QUICKTIME

Select ‘File’ from the main menu

Select `Reload QuickTime Waveform’. This will  re-establish the link between 
VoiceQ and your QuickTime movie file.

 Note: This is helpful  if you get out of synch between the scrolling text and the 
video.

 Note: When reopening the VoiceQ project VoiceQ will prompt the user to either 
rescan the QuickTime movie or maintain it as-is.

SCRIPT EDITOR WINDOW COLUMN DESCRIPTIONS

Column Description
Script  Scene Description

 Dialogue – primary language
  Dialogue – secondary language
  Dialogue – third language
 And so on

Num A unique number associated with the line

Cmts A comments  icon indicating a comment exists for that scene or 
line

Done
A checkbox  used to track progress of the user
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Column Description
Character Name of the script character that is associated with the line.  Char-

acter will also be color-coded.  To view the color  coding of the 
characters use the “Window” menu Characters command (or 8)

Start Shows the start time of the dialogue in HH:MM:SS:FF (frames)
End Shows the end time of the dialogue in HH:MM:SS:FF (frames)
Duration Shows the duration of the entire dialogue in HH:MM:SS:FF 

(frames)
Words Shows the number of words in the line or scene

Table 7.3

USER INTERFACE (VOICEQ DUB)

Figure 7.23

The screen shown in Figure 7.23 gives the option to change the primary language shown in 
the Script Editor Window.

 From the Main User Interface we are able to:

CHOOSE THE PRIMARY LANGUAGE IN WHICH LINES WILL BE DISPLAYED

Click in the language box as seen in Figure 7.23.

This will show you a list of all available languages for display.

Select the language you wish to use as your primary language

 Note: It is only possible to edit lines when they show as the current language.

SET THE ZOOM SIZE OF THE TIMELINE VIEW

Click on the zoom slider bar as seen in Figure 7.24.

Figure 7.24
Moving the arrow to the left will zoom out, moving the arrow to the right will  zoom 
in.

If you select a line of dialogue before zooming, it will stay centered in the timeline 
view.

PREVIEW A LINE BEFORE RECORDING

Click the Preview Line button (F1)  as seen in Figure 7.23.

If the button is glowing green  the highlighted line will  be displayed statically 
on the movie display in its entirety.
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 Note: This is extremely helpful when there is a long line and the Actor needs a 
preview of an upcoming line before recording.

DISPLAY TIMECODE IN PICTURES

Click the Timecode in Picture button (F2)  as seen in Figure 7.23.

If the button is glowing green  the timecode will be displayed on the output 
window.

 Note: You can adjust the timecodes position on the screen in the Preferences > 
Display.

DISPLAY SCROLLING RULER FOR MIXING

Click the Ruler button (F3)  as seen in Figure 7.23.

If the button is glowing green  the Ruler is displayed on the movie display.

 Note: This is extremely helpful  for making notes and spotting for SFX during the 
audio mixing process.

DISPLAY SCROLLING WAVEFORM

Click the Scrolling Waveform button (F4)  as seen in Figure 7.23.

If the button is glowing green  the scrolling waveform will be displayed on the 
output window.

 Note: You can adjust the waveforms size and position on the screen in the Prefer-
ences > Display.

DISPLAY SCROLLING TEXT IN PICTURES

Click the Scrolling Waveform button (F5)  as seen in Figure 7.23.

If the button is glowing green  the scrolling text will be displayed on the output 
window.

 Note: You can adjust the timecodes position on the screen in the Preferences > 
Display.

AUDIBLE BEEP COUNTDOWN

Click the Scrolling Text button (F6)  as seen in Figure 7.23.

If the button is glowing green  with a numeral 1 displayed then the beep 
countdown will trigger on the currently highlighted line.

If the button is glowing green  then the beep countdown will  trigger on all 
lines.

 Note: You can adjust the Audible Beeps options in the Preferences > Cues > 
Beeps.

  Make sure you use the character filter before proceeding with beeps on all  lines 
otherwise beeps will be enabled for all lines and all characters.
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VISUAL STREAMER

Click the Scrolling Text button (F7)  as seen in Figure 7.23.

If the button is glowing green  with the numeral  1 displayed then the stream-
ers will trigger on the currently highlighted line only.

If the button is glowing green  then the streamers will trigger on all lines.

 Note: You can adjust the Visual Streamer options in the Preferences > Cues > 
Streamers.

  Make sure you use the character filter before proceeding with streamers on all 
lines otherwise streamers will be enabled for all lines and all characters.

DISPLAY ON EXTERNAL MONITOR

Click the External Display button (F8)  as seen in Figure 7.23.

If the button is glowing green  the movie will be output full  screen on an ex-
ternal display through the second DVI port of your computer. 

 Note: If the button is greyed out then there is no suitable display connected or no 
second DVI port available.
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PROJECT SETTINGS (VOICEQ DUB)
VoiceQ DUB gives the user the option of selecting one primary language and as many addi-
tional languages as required for the purpose of dubbing film into multiple languages.  

It is also possible for VoiceQ to be used as a same language to same language service. An 
example of this use may be to record in the same or similar primary language but in another 
dialect or accent. It may also be used to re-record lines of dialogue (ADR) where the original 
sound track was impaired (for instance unexpected airplane noise etc).

Figure 7.25

Figure 521 of the language window shows the languages that may be used in VoiceQ in the 
Global  Window (left window) and the languages being used for the project in the Project 
Window (right window). 

TO SELECT THE PRIMARY LANGUAGE

Click on the language you would like to select as your primary language from the 
list in the Global Window in Figure 7.24.

Click on the  symbol to select your primary language.

Your selection will be displayed at the top of the Project Window.

TO SELECT ADDITIONAL LANGUAGES

Click on the language you would like to select as your additional  language from 
the list in the Global Window in Figure 7.24.

Click on the  symbol to select your additional language.

Your selection will be displayed in the Project Window.

 Note: It is possible to have any number of additional  languages by selecting them 
one at a time.

 Note: All  languages will also appear as a selectable option in the Language 
Screen as in Figure 7.23.

TO REMOVE ADDITIONAL LANGUAGES

Click on the language you would like to remove as your additional  language from 
the list in the Project Window in Figure 7.24.

Click on the  symbol to remove your additional language.

Your selection will be removed from the Project Window

  Note: It is possible to remove any number of additional  languages by selecting 
them one at a time.
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Chapter 8.      MAIN MENU ITEMS

This chapter will explain the Main Menu Items and their use within the VoiceQ application

VOICEQ MENU TAB

ABOUT VOICEQ
“About VoiceQ” will take you to the VoiceQ License Agreement as seen below.  
The full license may be read in Chapter 13.

Figure 8.1

PREFERENCES > GENERAL
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Figure 8.2

The preference window allows you to change various settings within the VoiceQ application.

PREFERENCES COMMANDS TABLE

Menu Item What this will do:
Timeline View Follow 
mode:

You are given four options:
1. No Follow – the display in the Timeline Edi-

tor will remain static.
2. On scrub and stop messages – the display 

in the Timeline Editor will correlate to the 
appropriate line where you stop and start 
that line frame by frame.

3. Constant - the display in the Timeline Editor 
will  scroll from the end of one scene to the 
beginning of the next scene

4. Constant with scrolling – will scroll  the Time-
line Editor view and follow each line for the 
duration of the film

Autosave When checking this tick box VoiceQ will  automati-
cally save the project in the folder indicated. You can 
configure how often you want VoiceQ to save the 
project. The save interval  varies from 5 minutes up to 
60 in five minute intervals.

Play Movie Audio When checked VoiceQ will play the sync audio from 
the quicktime movie.

Preroll Set the duration of the preroll  command (control 
spacebar)

Output MMC Output locate information via MIDI Machine Control  - 
set on for cueing of Pro Tools/DAW

Preroll Preroll value for MMC locate command
Table 8.1
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PREFERENCES > DISPLAY

Figure 8.3

PREFERENCES > DISPLAY COMMANDS TABLE

Item What this will do:
Display output as: Output the movie on the local computer screen or an 

external display
Display latency: Sets the display latency compensation in millisec-

onds
Preview highlighted 
line

Display the highlighted line in its entirety on the out-
put window

Altitude Sets the altitude of the preview line

Show timecode Display the current timecode in the output window

Altitude Sets the altitude of the timecode
Horizontal position Sets the latitude of the timecode

Show Ruler Display a scrolling ruler in feet and half feet on the 
output window

Altitude Sets the altitude of the ruler
Size Sets the size of the scrolling ruler
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Item What this will do:
Show waveform Display a scrolling waveform on the output window

Altitude Sets the altitude of the scrolling waveform
Size Sets the size of the scrolling waveform
Waveform transparency Sets the transparency of the scrolling waveform

Table 8.2

PREFERENCES > CUES

Figure 8.4

PREFERENCES > CUES COMMANDS TABLE

Item What this will do:
Show scrolling text Displays the scrolling text on the output window

Font Displays the currently selected font

Color Sets the color of the scrolling text
Change Change the desired display font for the scrolling text
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Item What this will do:
Scroll speed Sets the scroll speed of the scrolling text
Trigger position Sets the position of the trigger bar
Bar   transparency Sets the transparency of the scrolling text bar

Beeps Off: No beeps
On current line: Activates audible beep countdown on 
the currently highlighted line only
On Every line: Activates the audible beep countdown 
on every line.

Volume Sets the volume of the audible beep countdown
Frequency Sets the frequency (pitch) of the beeps
Duration Sets the duration (length) of the beeps
Timing Sets the timing (space) between the beeps
With visual countdown Activates a visual countdown on the output window
Streamers Off: No streamers

On current line: Activates visual streamer on the cur-
rently highlighted line only
On Every line: Activates visual  streamer on every 
line.

Altitude Sets the altitude of the streamers on the output win-
dow

Width Sets the width of the streamer bars
Height Sets the height of the streamer bars
Duration Sets the duration that the streamer takes to close
Color From character: uses the color codes from the char-

acters for the streamer bars
Custom: Set a custom color for the streamer bars

MIDI Sets the MIDI/GPI event sequencer to trigger 
streamer events from an external source

Table 8.3

VOICEQ MENU COMMANDS TABLE

Menu Item What this will do:
About VoiceQ Displays the about info box
Preferences Displays the preferences window
Services These are the standard Apple Macintosh commands
Hide VoiceQ Allows you to hide VoiceQ from sight – ie minimize s 

the window 
Hide Others Will  hide any other programmes running at the same 

time as VoiceQ
Show All Will reveal all programmes currently running
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Menu Item What this will do:
Quit VoiceQ Shuts down the VoiceQ application.

 Make sure you save your work before Quitting 
VoiceQ.

Table 8.4

FILE MENU

FILE MENU COMMANDS TABLE

Menu Item What this will do:
New  N Create a new project file

Open…  O Open an existing project file
You can also use this to open a text file in the correct 
script format to import into VoiceQ.

Associate QuickTime… Use this command to associate your VoiceQ project 
with a QuickTime Movie

Play Quicktime audio When checked the quicktime movies audio will play
Reload QuickTime wave-
form

Use this command to reload the waveform from the 
QuickTime Movie you have already associated with 
your VoiceQ project.

Use Live Feed Use this command to associate your VoiceQ project 
with an external Movie. VoiceQ will run with whatever 
video signal is being fed into your DV converter.

Open Recent Will  show current file open, recent files opened and 
give you the option to clear the menu

Close  W Closes the current file and quits the application
 Make sure you save your work before closing the 
project.

Save  S Saves the current file – this will write any changes 
you have made to the file since it was opened

Save As … S Saves the current file with a new name – will not 
change the original file 

Revert Reverts back to the last time you saved your project 
Upload to QML… Project –allows you to upload a project to the QML 

system
Scene – allows you to upload a scene to the QML 
system

Download from QML… Project –allows you to download a project from the 
QML system
Scene – allows you to download a scene from the 
QML system
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Menu Item What this will do:
Reports… Script Report – produces an HTML report with the 

following attributes: Scene description, line number, 
character, line (in all languages), start and end time-
code. It is sorted numerically by line number.

Export Script Report – produces an HTML report as 
above with the following additional attributes; scene 
comments, line comments and duration time codes. It 
is sorted numerically by line number.

Character Script Report – produces an HTML report 
with the following attributes: Character, line number, 
line (in all  languages), comments and start and end 
timecode. It is sorted by character based on the order 
as it appears in the character project window.

Character Line Summary Report – produces an 
HTML report with the following attributes: Character, 
line number, line (in all  languages), line comments, 
start and end timecode, Total  count of all incomplete 
lines per character, total timecode duration of all in-
complete lines per character, summary total count of 
all  incomplete lines for all  characters and total time-
code duration for all  characters. It is sorted by char-
acter based on the order as it appears in the charac-
ter project window.

Character Line Progress Report – produces an 
HTML report listing all `Incomplete Lines’ for all char-
acters and a summary count. Contains the following 
attributes: Character, line number, Total line count per 
character, total timecode duration per character, total 
line count for all  characters and total timecode dura-
tion for all characters. It is sorted by character based 
on the order as it appears in the character project 
window.

ADR Cue List Report – produces an HTML printable 
report for managing ADR Takes. Contains the follow-
ing attributes: Line start timecode, Character, line (in 
all  languages), comments, line (Cue) number, Pre-
ferred Take box and Empty Take Boxes for scoring. It 
is sorted by character based on the order as it ap-
pears in the character project window and line (Cue) 
number.

Table 8.5
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EDIT MENU

EDIT MENU COMMANDS TABLE

Undo  Z Undo the previous action

Redo  Z Redo the previous action

Cut  X Cuts highlighted sections of text or whole line if se-
lected

Copy  C Copies highlighted sections of text or whole line if 
selected

Paste  V Inserts cut or copied sections of text or whole line if 
selected

Delete Deletes highlighted sections of text

Locked_Line_Numbers Enables/disables automatic line numbering

Spelling Spelling…
Check Spelling
Check Spelling as you type

Special Characters Inserts special characters, symbols etc 
Table 8.6

ACTIONS MENU

ACTIONS MENU COMMANDS TABLE

Add Scene  Y Allows you to manually insert a scene at the selected 
point

Delete Scene  ⇧Y Allows you to delete a scene

Split Scene Allows you to split an existing scene into two scenes 
at the selected point

Add Line  L Allows you to manually insert a line at the selected 
point

Delete Line  L Allows you to delete a line

Spot Line Start       , Spots the start of a line

Spot Line End        . Spots the end of a line

Previous Line         M Goes back to the previous line for spotting

Next Line                 / Goes to the next line for spotting

Table 8.7
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WINDOW MENU

WINDOW MENU COMMANDS TABLE

Zoom Enlarges the window to fill the screen

Characters …  8 Reveals or hides the Project Characters drawer ei-
ther side of the main window

Project Set Up… 9 Reveals or hides the Project Settings drawer at the 
bottom or top of the main window

Bring All to Front Brings all  the VoiceQ windows to the front of the 
screen

Table 8 .8

HELP MENU

Will  take you to the Support Facility on the VoiceQ Website by default. This VoiceQ User 
Manual, in pdf format, is located under the `Downloads’ section. Please refer to the FAQ and 
User Forum sections which contain up to date user information. If you still require assistance 
you may log a support ticket from the Support Contact section.

 Note: You must have a connection to the Internet to access the Support Facility 
and download the VoiceQ User Manual.
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Chapter 9.      CREATING A PROJECT

This chapter will give an overview of starting a project in VoiceQ.

CREATING A PROJECT BY IMPORTING A SCRIPT

To create a project by importing a script, it is necessary to have the script available on your 
computer in the prescribed format. Use the Script Import Manager (SIM) to pre-process 
script documents into the required format for VoiceQ.

CREATING A PROJECT BY INPUTTING A SCRIPT

If you don’t have access to a text file of your script, it is still  possible to use VoiceQ for your 
translation. However, you will  need to input the script manually in the VoiceQ application 
using the directions in the following pages.

CREATING A PROJECT FOR USE WITH QML
To access the features of QML you must first create the primary language project in VoiceQ 
DUB by either importing from a script or manually entering the dialogue in VoiceQ. Once the 
primary language project has been created it may be ‘uploaded’ to QML. This initial upload 
creates a unique link between the VoiceQ project file and the QML project. This project file is 
required to download any additional languages added via QML.

 Additional  languages may be added via the QML web interface for translation. Once these 
translations are completed the project may be downloaded and the additional languages will 
be available in VoiceQ DUB.

To upload a project to QML you will  need to be registered with the QML language translation 
service and have a connection to the Internet.

HOW TO MANUALLY CREATE A PROJECT

Create a project manually by opening the VoiceQ application, you will  be presented with a 
new project. Select Save As... from the file menu and save your project in the desired loca-
tion.

The following sub-chapters explain how to create scenes etc in your new project.

HOW TO CREATE SCENES

Create a scene by clicking in the Script Editor Window and go to Action > Add Scene. You 
can also delete a scene by selecting the scene in the script view and then using Action > 
Delete Scene.

ADD A NEW (BLANK) SCENE TO THE PROJECT. 

Expand the Scene view to include the characters by clicking on the  symbol 
beside the scene description.

Click in the white area on the screen.

Go to the ‘Action’ item on the main menu 

Select ‘Add Scene’ or use Y
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HOW TO CREATE LINES

Create a line by clicking on a Scene Header in the Script Editor Window, then select Action 
> Add Line. You can also delete a line by using Action > Delete Line.

ADD/INSERT A NEW LINE INTO THE SCENE. 

Expand the Scene view to display the lines within it by clicking on the  symbol 
beside the scene description.

Click in the timeline where you want the line created

Go to the ‘Action’ item on the main menu and select ‘Add Line’ (or use L)

Note: Lines will not appear on screen until the have been assigned a Character.

HOW TO CREATE CHARACTERS

ADD CHARACTERS 

Ensure the Character screen is showing by clicking on ‘Window’ from the main 
menu and selecting Characters… or use 8

Click on the Add Character button at the centre of the Character screen as 
shown in Figure 7.13.

This will open a colored box in the upper half of the screen. Double click in the 
box and enter your character name here.

When you have completed editing, click outside the box.

 Note: If you press [return] when you have completed editing the character name, 
the cursor will move to the next character in the list or insert a new one.

HOW TO CREATE LANGUAGES

TO SELECT THE PRIMARY LANGUAGE

With the Language Screen open click on the language you would like to select as 
your primary language from the list in the Global Window in Figure 7.25.

Click on the  symbol to select your primary language.

Your selection will be displayed as the first language listed in the Project Window.

TO SELECT ADDITIONAL LANGUAGES

With the Language Screen open click on the language you would like to select as 
your additional language from the list in the Global Window in Figure 7.25.

Click on the  symbol to select your additional language.

Your selection will be displayed in the Project Window

 Note: It is possible to have any number of additional languages, but they must be 
selected one at a time.

 Note: Languages added in the Language Screen will also appear as a selectable 
item in the Language Screen selection box as in Figure 7.24.
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Chapter 10.      OUTPUT VIEW AND WORKFLOWS

This chapter explains the output view of VoiceQ and generic workflows.

The video output of the VoiceQ application is the quicktime movie with optional cueing sym-
bols superimposed. The VoiceQ scrolling text scrolls from the right hand side of the screen 
towards the ‘target line’ on the left. Actors read the dialogue when it hits this line to achieve 
lip sync. Other cueing methods such as streamers (also called wipes) and a visual and 
audible countdown (3, 2, 1 go) are also displayed over the video.

The output view has the following features:

The VoiceQ scrolling text is overlaid on a live display of the movie file associated 
with the project.

The display may be in either a window on the main display of the computer, or full 
screen on a secondary display.

The following diagrams describe generic  workflows when adopting VoiceQ into your proc-
esses. Integrating VoiceQ and/or QML allows for seamless implementation and interaction 
with your current processes.

Contact KIWA if you need additional information on integrating VoiceQ into your workflow.
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Figure 10.1
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Figure 10.2
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Figure 10.3
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Chapter 11.      USING A `LIVE FEED’ AS THE VIDEO SOURCE

If you are not using QuickTime as your video source then it is possible to send the output of 
your current video card (eg. AVID Mojo) into a common DV converter attached to the firewire 
port.

To activate the “Live Feed”

Select File > Use Live Feed.
VoiceQ will  now render the synchronized scrolling text over the incoming live video signal 
and output it via the DVI port of your computer. When using the Avid Mojo and AVID video 
you will need to offset the video by 4 frames in ProTools 7.2.

This gives you the added flexibility to remain with your current video playback set-up and 
save on formatting issues within your facility, maximizing your previous investments.

Figure 11.9
When using the Avid Mojo and QuickTime movies you will need to offset the video by 32-
quarter frames in ProTools 6.x and 7.x.

Figure 11.10
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If you are using both Avid Video files and the QuickTime format within your ProTools session 
then you can allocate both offsets within ProTools 7.2 creating a truly multi-format environ-
ment with VoiceQ.

You are now ready to record your ADR or Dubbing session using Pro Tools and VoiceQ.
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Chapter 12.      QML IMPORT / EXPORT SPECIFICATIONS

This chapter explains the import / export specifications for VoiceQ.

WHAT IS QML?
QML enables the translation of film and TV scripts to take place in any corner of the globe 
with an Internet connection and download it ready for recording in a matter of seconds.

Figure 12.1
The QML system (anagram for Queue My Lips) is a web enabled translation management 
system that enables script translation and validation from any language, into multiple other 
languages while providing essential management and workflow tools to make the process 
as efficient and effective as possible.

Once you have subscribed to QML you will  be issued with a user ID and password.  This 
access enables you to use and interact with the QML system and allows scripts to be trans-
lated and adapted into multiple languages, under your management.  

QML has an interface with VoiceQ DUB and both systems work collaboratively to synchro-
nize translated dialogue ready for studio recording.

In addition, QML provides accurate Export Scripts in primary and translated languages as 
well as a set of management reports to enhance the overall  efficiency and effectiveness of 
the process.  eg. loop reports, by project, by scene, by character and by line with timecode 
and summary information to aid in voice recording and talent scheduling.

Script administrators, translators, adapters and editors can be anywhere in the world and 
only need Internet and email access to complete their responsibilities.  The project or pro-
duction manager has full  visibility of the projects with management information provided 
real-time to track and measure the status of the project and keep it on track.
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The interface with QML works only one way in that files can be imported from and exported 
to QML but cannot be sent by QML to VoiceQ DUB.  This business rule has been built into 
both products on the premise that VoiceQ DUB is the ‘Master’ and is the most accurate re-
pository of recorded dialogue.

 Note:  You must create a VoiceQ Project in VoiceQ DUB first before interacting 
with QML. This ensures that there is an established link between the two systems 
and allows correct operation.

QML upload (sending from VoiceQ to QML) and download (retrieving from QML to VoiceQ) 
operations take place across an https session to the QML server.

Four functions are supported:

Verification of a valid username and password

Placing work to be translated (export from VoiceQ project to QML)

To retrieve an entire project and its translated scripts (import file into VoiceQ from 
QML)

To retrieve just a single scene and its translation(s) (import scene into VoiceQ 
from QML)

When exporting, the application will provide as many translations as has been requested, 
marking each with an ISO 639-1 two character code. The first line provided will always be in 
the primary language. In most cases this will be the only language, but the web application 
is expected to deal with the case where there are translations already there and where we 
are re-exporting due to additional languages being added or edits removing already trans-
lated lines. 

On importing, the application will  import as many translations as are provided.  More than 
one scene may be sent at once, but only one root object (i.e. the vqproject) will exist. 

To subscribe to QML or for further information about QML, contact KIWA International.
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Chapter 13.      SCRIPT IMPORT MANAGER (SIM)
This chapter provides an overview of the Script Import Manager (SIM) application. Please 
refer to the Script Import Manager User Manual for full details.

WHAT IS SIM?
VoiceQ's Script Import Manager (or SIM for short) is the first-ever software tool  for importing 
and managing film and television scripts for ADR and dubbing. VoiceQ's SIM uses leading 
edge technology to extract dialogue information from scripts ready for importing into VoiceQ. 
The Script Import Manager (SIM) has been designed to make importing information into 
VoiceQ quick, accurate and easy. This software is a world first and uses advanced pattern 
recognition and rule sets to extract the data from scripts required for VoiceQ. The module 
also fixes errors in Character names and timecodes, preventing these errors from getting 
into your ADR or Dubbing session. In addition, SIM can import Pro Tools session text files 
for Foley sessions and convert them ready for import into VoiceQ.

SIM provides the ability to define and save rule sets for specific  file formats that can be used 
over and over again. Rule sets can be imported and exported meaning you can exchange 
predefined rule sets with other users to build a complete library of rule sets readily available 
at anytime.

The SIM extracts the required data and outputs a correctly formatted text file ready for im-
porting into VoiceQ. SIM has been developed in Java, and will run on Mac  OS X, Linux and 
Windows, meaning script preparation can be performed on any operating system and plat-
form.

SIM has been designed to handle multiple languages and character sets and uses savable 
rulesets to parse the files for quick workflow.

This simple process involves:

a. Importing a file

b. Selecting a default ruleset or creating a new ruleset

c. Converting the file into the VoiceQ file format

d. Correcting any errors that are displayed

e. Exporting the file ready for VoiceQ.
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Figure 13.1 - SIM Main Script View

SIM TECHNICAL SPECIFICATIONS

SIM is compatible with any system that can run a java application including Mac OSX, Win-
dows and Linux. SIM has been successfully tested on a number of Macintosh and Windows 
platforms, running various OSX and Windows versions. As a uni-code and universal  applica-
tion SIM is built to manage Text, Excel and Word documents in any language, character set 
and font on both Intel and Power PC's. 

Other file types are being added as part of KIWA's ongoing development program.

This multi-platform, universal and uni-code SIM Application is provided FREE with 
every VoiceQ Application.

VOICEQ USER MANUAL

© 2004-2008 KIWA International Ltd - 84



Chapter 14.      SUPPORT

For all enquiries and technical support contact: 

North America Head Office:
KIWA International Ltd
Telephone:    1 800 371 2792
Email General Enquiries: info@voiceq.com
Email Technical Support: support@voiceq.com
Website:   www.voiceq.com

New Zealand and Australasia Head Office:
KIWA International Ltd
PO Box 41136
St Lukes
Auckland
New Zealand

Telephone:    +64 9 375 2865
Fax:    +64 9 375 2867
Email General Enquiries: info@voiceq.com
Email Technical Support: support@voiceq.com
Website:   www.voiceq.com

All other Countries:
Email General Enquiries: info@voiceq.com
Email Technical Support: support@voiceq.com
Website:   www.voiceq.com  
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Chapter 15.      GLOSSARY OF TERMS

Term Description
Application Refers to VoiceQ programme

Character Part played in movie

Dialogue Spoken lines from a script

Episode A set of scenes

Export Script A document containing scene descriptions, characters, dialogue lines 
and time codes for each completed film project.

Fps Frames per second. A measure of the film or video display rates (NTSC 
= 30 fps, 30(d) fps PAL = 25 fps Film = 24 fps.)

Frm Frames

Hardware Computer equipment and accessories

Hrs Hours

ISO International Standard Organization

Lines Dialogue – speech of character

Loop A line of dialogue.  Film and Television terminology for a spoken line.

MIDI Musical Instrument Digital Interface

Min Minutes

NTSC National Television Standards Committee. The group that established 
the color television transmission system used in the Untied States. The 
standard calls for 525 lines of information scanned at a rate of approxi-
mately 30 fps

PAL Phase Alternating Line. A color television standard used in many coun-
tries. PAL consists of 625 lines scanned at a rate of 25 fps.

Project A set of scenes containing script data and an associated movie. A pro-
ject maybe anything from feature or short film, television series, episode 
or special to a commercial or advertisement.

QML Que My Lips – web enabled language translation management system 
with an interface to VoiceQ DUB. Provides accurate translation and ad-
aptation of original  scripts into multiple language scripts using workflows 
and other aids. Produces Export Scripts in multiple languages and full 
set of management reports.

QuickTime Multimedia architecture to view, create, import and export media. Used 
with VoiceQ to display scrolling dialogue on video for recording pur-
poses. QuickTime Player is available to download free from the internet 
at www.apple.com 

Scene A logical segment of a script 

Sec Seconds

SMPTE Society of Motion Picture and Television Engineers. One of the principal 
standards organizations for the film and video industry

Software Computer programme 

UI User Interface (aka GUI)

Unicode A two alpha code that differentiates international languages
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Term Description
Waveform Graphic representation of sound

Quick Keys Reference Guide

Feature Quick Key Function

Add line ⌘L Allows you to manually insert a line at the se-
lected point

Add Scene ⌘Y Allows you to manually insert a scene at the se-
lected point

Advance 1 frame ⌘+ Forward one frame

Advance 1 second ⌥⌘+ Forward one second

Advance 10 sec-
onds

⌃⌥⌘+ Forward ten seconds

Audible Beeps F6 Play audible beeps countdown on a highlighted 
line or all lines

Characters… ⌘8 Reveals or hides the Project Characters box ei-
ther side of the main window

Chase Ext Time-
code

⌘J Enables VoiceQ to chase external MTC. Toggles 
On and Off

Close ⌘W Closes the current file but does not quit the pro-
gram.

Copy ⌘C Copies highlighted sections of text

Cut ⌘X Cuts highlighted sections of text

Decrease Scroll 
Speed

⌘[ Decrease the scroll speed

Delete Line ⇧⌘L Deletes a line

Delete Scene ⇧⌘Y Deletes a scene

Drag all words in 
line

⌘ drag Dragging a word in the timeline view will affect all 
words after the one selected in the current line

Drag following 
words in line

⌥ drag Dragging a word in the timeline view will affect all 
words before and after the one selected in the 
current line

Drag previous words 
in line

⌃ drag Dragging a word in the timeline view will affect all 
words before the one selected in the current line

External Monitor F8 Outputs movie to internal or external monitor

Increase Scroll 
Speed

⌘] Increase the scroll speed

Locate to Start return Locates to the start of the movie
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Minimize ⌘M Minimizes window

New ⌘N Creates a new VoiceQ Project

Open All Lines ⌥ click Opens and closes All Lines when Scene is high-
lighted, including all languages

Open… ⌘O Opens an existing VoiceQ Project . Also used to 
imports a text file into VoiceQ.

Paste ⌘V Inserts cut or copied sections of text

Play QuickTime 
Audio

⇧⌘M Play QuickTime audio. Toggles On and Off

Play with Pre-roll ⌃space bar Plays selected line with a pre-roll value set in 
preferences

Play/Stop space bar Plays and stops movie

Preferences ⌘, Opens VoiceQ Preferences Window

Preview Line F1 Displays a static preview of the highlighted line 
onto the display. Toggles On and Off

Project Settings ⌘9 Opens Project Settings window

Quickspot line end period (.) Spots the end of a highlighted line to the timeline

Quickspot line start comma (,) Spots the start of a highlighted line to the timeline

Redo ⇧⌘Z Redo previous actions

Rewind 1 frame ⌘- Backward 1 frame

Rewind 1 second ⌥⌘- Backward 1 second

Rewind 10 seconds ⌃⌥⌘- Backward 10 seconds

Save ⌘S Saves the current file

Save As … ⇧⌘S Saves a copy of the current file with a new name

Scrolling Ruler F3 Outputs feet and half feet Ruler onto the display. 
Toggles On and Off

Scrolling Text F5 Toggles the text On and Off on the display

Scrolling Waveform F4 Toggles the scrolling waveform On and Off on the 
display

Select next line forward slash (/) Selects next line for spotting

Select previous line m Selects previous line for spotting

Special Characters ⌥⌘T Displays the Special Character Palette 

Streamers F7 Toggles the streamers On and Off on the display

Timecode F2 Outputs VoiceQ timecode onto the display. Tog-
gles On and Off

Undo ⌘Z Undo previous actions
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Chapter 16.      VOICEQ END USER LICENSE AGREEMENT 

This chapter explains the End User License Agreement you are agreeing to by purchasing 
the VoiceQ application license and the Support and Maintenance terms and conditions.

VOICEQ END USER LICENSE AGREEMENT
This is a legal agreement between you and KIWA International  Ltd, a New Zealand regis-
tered company, covering your use of VoiceQ and related products and materials (the "Soft-
ware"). Be sure to read the following agreement before installing or using the Software. BY 
INSTALLING OR USING THE SOFTWARE (REGARDLESS IF YOU HAVE PURCHASED 
THE SOFTWARE OR NOT), YOU ARE AGREEING TO BE BOUND BY THE TERMS OF 
THIS AGREEMENT. IF YOU DO NOT AGREE TO THE TERMS OF THIS AGREEMENT, DO 
NOT INSTALL OR USE THE SOFTWARE AND DESTROY ALL COPIES IN YOUR POS-
SESSION.

Subject to full payment of the Software registration fee and your compliance with the terms 
of this Agreement, you are hereby licensed to use the Software.  KIWA International  re-
serves the right to terminate this license at any time, for any reason.

Reselling of the Software without the prior written consent of KIWA International is strictly 
prohibited. If you wish to incorporate the Software into your own commercial products you 
must first contact KIWA International for written permission. You may not distribute any cop-
ies of the Software whatsoever.

By using the Software, you acknowledge that the Software and all related products consti-
tute valuable property of KIWA International  and that all title and ownership rights to the 
Software remain exclusively with KIWA International under license.  KIWA International re-
serves all  rights with respect to the Software under all  applicable laws for the protection of 
proprietary information, including, but not limited to, trade secrets, copyrights, trademarks 
and patents.

The Software is owned by VoiceQ International Ltd and has granted an exclusive world-wide 
right to KIWA International Ltd to use, produce, market, distribute and sell the Software. The 
Software is protected by New Zealand copyright laws and international copyright treaties, as 
well as other intellectual property laws and treaties. Therefore, you must treat the Software 
like any other copyrighted material  (e.g. a book or musical recording). The Software is li-
censed, not sold. Paying the Software registration fee allows you the right to use one copy 
of the Software on a single computer. You may not network the Software or otherwise use it 
or make it available for use on more than one computer at the same time. You may not rent, 
lease or lend the Software, nor may you modify, adapt, translate, reverse engineer, decom-
pile, or disassemble the Software, nor may you assist or allow any other party to do any of 
these things.  You are responsible for all  use of the Software, whether or not authorized by 
you.

If you violate any part of this agreement, your right to use the Software terminates automati-
cally, you must immediately destroy all copies of the Software and Documentation in your 
possession, KIWA International reserves the right to take action for damages or other reme-
dies, should it consider that appropriate, and you agree to indemnify KIWA International for 
any liabilities, costs and/or expenses (including legal costs) KIWA International directly or 
indirectly incurs as a result of your breach.

The Software and its related documentation are provided "AS IS" and without warranty of 
any kind and KIWA International expressly disclaims all  other warranties, expressed or im-
plied, including, but not limited to, the implied warranties of merchantability and fitness for a 
particular purpose.  In particular, you acknowledge that the Software cannot be guaranteed 
error-free and that the existence of any errors shall not constitute a breach of this Agree-
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ment.  Under no circumstances shall KIWA International be liable for any incidental, special, 
or consequential damages that result from the use or inability to use the Software, even if 
KIWA International has been advised of the possibility of such damages. In no event shall 
KIWA International’s liability exceed the Software registration fee paid, if any.

The laws of New Zealand apply to this license and any dispute arising under or in relation to 
it.

Copyright © 2008 VoiceQ International Limited, "VoiceQ",  “VoiceQ ADR”, “VoiceQ DUB”, “KEEPING 
SOUND ON TRACK”, “BREAKING SOUND BARRIERS” and Logos are trademarks of  VoiceQ Interna-
tional Ltd and may  not be copied without written permission. “VoiceQ®” is a New Zealand registered 
trademark.  Copyright © 2008 QML International Limited, “QML”, “CUE MY LIPS” and Logos are 
trademarks of  QML International Ltd and may not be copied without written permission. Copyright © 
2008 KIWA International Limited, "KIWA”,  “KIWA International",  “SOUNDS SUITE”, “Script Import 
Manager”,  “SIM” and Logos are trademarks of  KIWA International Ltd and may  not be copied without 
written permission. New Zealand Patent 532174. All Rights Reserved.
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Chapter 17.      VOICEQ ASSURANCE

KIWA International’s Technical Support And Software Maintenance 
Services Schedule

A. Technical Support and Software Maintenance Services
Definition of Terms: 
Commencement Date means the date on which the End User is provided with a VoiceQ 
Key; Documentation means all  instruction manuals, user guides, training material and other 
information relating to the Software made available with the Software or through other com-
munication media; VoiceQ Key means a unique software registry key that allows the End 
User to enable, open or otherwise access the Software; Software means the VoiceQ ADR 
and VoiceQ DUB software; Support means the provision of updates to the Software and 
general support and maintenance services in respect of the Software, as set out in the 
Schedule; Support Fee means an amount equal to 10% of the then current License Fee, 
which is payable by the End User annually in advance in order to be eligible to receive en-
hanced Support; Warranty Period means 90 days from the Commencement Date; Website 
means voiceq.com. 

Subscription: End Users may subscribe to an annual Technical  Support and Software 
Maintenance service (“Support”) for KIWA International Products in accordance with the 
technical support and software maintenance services policies in effect on the date such 
services are ordered. If the End User wishes to receive Support, the End User must: 

(a) register with KIWA International, either directly or through the Website and supply 
an email address; and 

(b) pay the Support Fee. 

On payment of the Support Fee KIWA International will  issue confirmation by e-mail  to the 
End User and provide Support accordingly. If the End User has not paid for Support, the 
End User may nevertheless acquire new releases or upgrades of the Software on payment 
of the relevant fee specified on the Website or as otherwise notified by KIWA International. 
The term of such Support shall be for one (1) year beginning on the Effective Date of the 
Agreement (“Initial  Term”).  Thereafter, Support shall  automatically renew each year for suc-
cessive one (1) year terms at the same service level, unless either party gives written notice 
of its intent not to renew at least thirty (30) days prior to the end of the then current term.

Hardware and Services: The End User is solely responsible for acquiring, servicing, 
maintaining and updating all  equipment, computers, software and communication services 
that allow a user to access and use the Software. The End User acknowledges that the op-
eration and availability of the systems used for providing and accessing the Software, in-
cluding public  telephone services, computer networks and the Internet, can be unpredictable 
and may from time to time interfere with or prevent the provision of or access to the Soft-
ware. KIWA International  is not in any way responsible for any such interference with or pre-
vention of the End User’s access and/or use of the Software.

Warranties:  KIWA International warrants that it has complete authority to license the 
Software and the Documentation to the End User. KIWA International warrants that to the 
best of its knowledge and belief the software and the Documentation do not infringe any 
patent, copyright, trade secret or other intellectual  property right of any other party. KIWA 
International further warrants that, during the Warranty Period of 90 days from Effective 
Date, the Software will function substantially in accordance with the Documentation but the 
End User acknowledges that the Software is of an advanced and technical  nature and may 
have minor or inherent defects. KIWA International will provide reasonable endeavors and 
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remedial services to correct documented code errors caused by a defect in the Software 
available only during the Warranty Period. 

Support Fees:  Upon the Effective Date of this Agreement, End User shall  pay KIWA Inter-
national the Support Fees set at an amount equal to 10% of the then current License Fee for 
Services during the Initial Term. In the event this Agreement is renewed following the Initial 
Term, then, within thirty (30) days of such renewal date, End User shall pay KIWA Interna-
tional  Support Fees for Services in advance of the renewal term in an amount to be agreed 
upon by the parties or, in the absence of such agreement, based on the previous terms rate. 
In addition, End User shall  pay applicable Support Fees for any additional Software pur-
chased during the term of this Agreement.

Past Due Maintenance Payments: Without waiving or prejudicing any other rights or 
remedies, in the event End User fails to pay the Support Fees within thirty (30) days of the 
applicable due date, then, KIWA International shall suspend performance of Services and 
this Agreement shall lapse.

B. Description of Services  

Software: KIWA International Software Maintenance Service includes regular in-
version updates providing advance notification of future software releases and detailed fea-
ture information to assist with the End Users business planning; all minor and maintenance 
releases for products covered under the service agreement; the choice to receive the Soft-
ware electronically or from the Website.

Revisions of the VoiceQ application will  be released periodically.  Each revision will be des-
ignated as a patch or version upgrade. Each patch will address software defects found 
within a VoiceQ version, and will  be supplied at no charge to any End User that has pur-
chased the affected version.

There are two types of version upgrade: 

• A minor upgrade will  offer limited functional  improvements within a major version.  A 
minor upgrade is free to all End Users.  

• A major upgrade will offer significant functional improvements and constitute a new 
major version release.  End Users who elect to pay maintenance will be offered ma-
jor upgrades at a heavy discount on the appropriate version base price.  For End 
Users who have declined maintenance cover, major upgrades will  be offered at the 
applicable base price.

Technical Support: Technical Support Services entitle End User to unlimited technical 
Website and email support incidents per year. The service is provided for single site installa-
tions, multi-sites in the same country or over several country boundaries.  Authorized per-
sonnel of the client are entitled to technical  Website and email support for an unlimited 
number of incidents. Technical support will  include assistance in the use of the Software. 
Such assistance may include configuration, identification of Software problems and work-
arounds when possible. KIWA International will  provide quality technical support in accor-
dance with generally recognized business practices and standards. Technical  support ex-
cludes hardware, system design, applications development, project management, facilities 
management, and support for incompatible products or third party products. No on-site as-
sistance is provided.

Termination of Support:  KIWA International shall have no obligation to provide Technical 
Support or Software maintenance services as set forth in this Section: 

(a) if End User does not elect to order such services or fails to renew such services, or 
fails to pay for such services;
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(b) if End User modifies the Products or Software without authorization; or
(c) in the event of problems due to Customer’s negligence, third  party hardware or 

software not provided by KIWA International or other causes not within KIWA Inter-
national’s control.

Reinstatement of lapsed annual Technical Services and Support Services will  be subject to 
the then-current reinstatement policy and payment of a Support fee, which shall be equal to 
the amount of the lapsed Support Fees. 

C.  Technical Support and Escalation Program 
Provided that End User is under a current Technical Support and Software maintenance 
services program, KIWA International  shall provide End User support as follows. KIWA In-
ternational will  investigate and use its best endeavors to correct Software faults reported by 
the End User.  A Software fault is a material discrepancy between the way the End User’s 
version of the Software operates and the description of the Software’s operation as set out 
in the Documentation when the Software is installed and used in accordance with the 
Documentation. Software faults will  be classified by KIWA International based on their se-
verity and impact on the End User’s ability to use the Software.

End User’s obligations and exclusions: The End User must: 

Make all reasonable efforts to investigate and diagnose problems with the Soft-
ware before contacting KIWA International; and

Report to KIWA International all  program errors it discovers so that KIWA Interna-
tional  can replicate the errors. Support does not include, and KIWA International 
may charge separately for, any services resulting from: 

Misuse of the Software or failure to use the Software in accordance with the 
Documentation; or 

Attempts to repair, replace, modify or maintain the Software by anyone other than 
KIWA International; or 

Have elected not to install  the latest releases or versions of the Software after 6 
months from the date KIWA International offered an update to the End User.

New Releases:  New releases of the Software will be provided via Email  or the Website as 
they become generally available. Release notes will be provided identifying significant 
changes and new features in the release as well as procurement procedures.

3.  REQUESTING TECHNICAL SUPPORT FROM KIWA INTERNATIONAL

The following procedures should be used when requesting warranty, contracted and billable 
services from KIWA International:

Step 1:  If you have a problem with your KIWA International Product, you must send an 
email to support@voiceq.com or log a `support ticket’ on our Website in the first instance. 

For a quick response please complete the appropriate Support Form accessible on the 
Website under `Support’. These forms are specifically designed to allow KIWA to capture all 
the information required for a quick response.

Follow up calls maybe made during standard business week days to:   

Standard Business Hours: 09:00am – 17:00pm NZST, week days excluding statu-
tory and regional public holidays at 
+64 (0) 9 375 2865 or,
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For US Only: Standard Business Hours: 09:00am – 17:00pm Pacific Standard 
Time, week days excluding statutory and regional  public holidays at 1 800 371 
2792.

All  responses from KIWA International will  be by email or by posting releases on the Web-
site. Extended support beyond these hours can be provided if required at KIWA Interna-
tional’s standard rate applicable at the time. 

Step 2:  Be prepared to give the following information:

If you are a maintenance customer, a KIWA International maintenance contract 
number for the site with the problem is required.   Also provide your company 
name, contact name, telephone number, e-mail  address, product name and prod-
uct version of the software that is experiencing the problem.

If you are a non-maintenance customer, a purchase order number is required. 
Also provide your company name, contact name, telephone number, e-mail  ad-
dress, product name and product version of the software that is experiencing the 
problem.

Step 3:  Provide an accurate description of the problem in your email or support ticket on our 
Website.   Please take note of the KIWA International Problem Priority Definition included in 
this guide.

Step 4:  The Customer Service Agent will  acknowledge receipt of your support request by 
return email.  Please record this acknowledgement for any future reference to this case.

Step 5:  Depending on the type of problem and priority level (Support Maintenance End 
User only), your problem will be assigned to a Customer Engineer for resolution.

Step 6:  After the service has been delivered, the Customer Engineer will confirm with you 
that the problem is resolved and close the case.
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